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Spreadsheets 1 – Introduction 

What are spreadsheets? 
Spreadsheets are used to organize data using cells. The values in those cells can be defined by 
formulas. Spreadsheets are commonly used for budgets, forecasting, and other finance­related tasks. 
Spreadsheets are made of 256 lettered columns and 65,536 numbered rows. 
Microsoft Excel is the name of the spreadsheet program we will be using. 
The screen you will see in Excel is arranged in rows and columns. 

Cell 
Each cell in a spreadsheet is a rectangular space that can hold text, a value, or a formula. 

Active Cell 
The highlighted cell on the spreadsheet is the active cell. 

Name Box 
Located in the top left corner, the name box displays the address of the selected cell. If you type a 
cell address in the name box and press ENTER you will go to that cell. 
(Example: B5 is the name for the cell located in column B, row 5.) 

Row Headings 
Row headings label the rows. Rows are a series of cells arranged horizontally. Numbers identify 
rows. Clicking a row heading selects an entire row. 

Column Headings 
Column headings label the columns. Columns are a series of cells arranged vertically. Letters identify 
columns. Clicking a column heading selects an entire column.
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Formula Bar 
Located on the top of the spreadsheet, below the toolbars, the formula bar displays text from the 
selected cell. If there is a formula in the cell, the formula, not the answer to the formula, is displayed 
in the formula bar. Clicking on the symbol next to the formula bar will assist you in entering formulas. 

Formulas 
A formula will instruct Excel to automatically do something (add, multiply, average, etc.) to a set of 
cells. To begin writing a formula in the formula bar, you must first type an equal sign =. 

Example formula: 
To put the total of cells A3, A4 and A5 into cell A7 you would click in cell A7 and type in the formula 
bar =A3+A4+A5 

Hint: When entering formulas, after you type an equal sign, instead of typing the cell names (A3, A4) 
click the cell you want to sum. 

Simple Formula: 

Click the cell in which you want the answer (result of the formula) to appear. Press Enter once you 
have typed the formula. 

All formulas start with an = sign. 

Refer to the cell address instead of the value in the cell e.g. =A2+C2 instead of 45+57. That way, if a 
value changes in a cell, the answer to the formula changes with it. 

+ means add  e.g. A2+C2  Add the value (number) in A2 to 
the value (number) in C2. 

­ means subtract  e.g. A2­C2  Subtract the value (number) in 
C2 from the value (number) in 
A2. 

* means multiply  e.g. A2*4  Multiply the value (number) in A2 
by 4. 

/ means divide  e.g. A2/3  Divide the value (number) in A2 
by 3.
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Functions: 

These formulas are used for working with long lists of numbers. A typical function looks like this: 

=SUM(A3:A30) 

• SUM is a function, meaning that it sums (adds up) the list of numbers. 

• The list of numbers is indicated in brackets. 

• The address of the first cell in the list is A3. 

• A colon : separates this cell address from the last cell in the list, which is A30. 

=SUM(B3:B9) 

Adds list of values from cell B3 to cell B9 

=AVERAGE(B3:B9) 

Averages the values from cell B3 to cell B9 

AutoSum 

Another way to calculate a sum in Excel is to use the AutoSum button.  Select the cells you wish 
to add together by clicking on the first cell and dragging your mouse across the other cells. Now click 
the AutoSum button.
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An Electronic Checkbook 
© 2002 Bill & Melinda Gates Foundation 

In this exercise you will create a basic checkbook balancing spreadsheet. 

Start Excel 
1.  Start the Excel program. 

2.  You may need to create a new blank workbook by clicking on the New button  at the far left of the 
toolbar. 

Enter Column Titles 
To enter text or numbers, first select a cell using the keyboard arrows or the mouse, then type the letters or 
numbers.  To move to the next cell, the Enter key will move down one cell, the Tab key will move one cell to 
the right.  You can also use the arrow keys to move in any desired direction 

1.  In cell A1 type Check #,  and press the right arrow key or Tab key to move to cell B1. 
2.  In cell B1 type Date. 
3.  In cell C1 type Description of Transaction. 
4.  In cell D1 type Payment/Debit. 
5.  In cell E1 type Deposit/Credit. 
6.  In cell F1 type Balance. 

Format Column Titles 
1.  Select the block of cells that have column titles. (Move your mouse pointer to cell A1. Click and hold 

down the left mouse button. Drag the mouse pointer to cell F1 and let go.) 
2.  Select Bold by clicking the B button on the toolbar. 
3.  With the block of cells still selected, click on the Format menu on the Menu bar near the top of your 

screen. 
4.  From the drop­down menu, click the word Cells. 
5.  Choose the Patterns tab and select any light color to fill in the cell backgrounds. 
6.  Click OK. 

Format Data 
This is a step you can do before or after entering data. Since we would like to be able to read the column titles 
clearly, let’s do this step first. 

1.  To make your spreadsheet look more professional, you need to format it. 
2.  Check to see if the colmn titles are still selected. If not, reselect them or select the entire columns by 

clicking and dragging from the Letter A at the top of the first comun to the letter F and let go. 
3.  To resize these columns click on the Format menu. Move down to Column (which has an arrow on its 

right side, showing you it has options you can choose from) and choose AutoFit Selection from the sub­ 
menu.
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Enter Data 
1.  Select cell A2. 
2.  Enter the following data: 

A  B  C  D  E  F 
1  Check #  Date  Description of 

Transaction 
Payment/ 
Debit 

Deposit/ 
Credit 

Balance 

2  5/1  Initial Deposit  200 
3  1001  5/2  Phone bill  45.52 
4  1002  5/5  Groceries  36.6 
5  5/10  Deposit  450 
6  1003  5/15  Rent  400 

NOTE:  As you enter the dates, the format will change, and data may not fit the column, turning into something 
like ####. If this happens, move your mouse between the column identifiers for B and C. When the mouse 
pointer changes to a black cross with arrows, double­click. This will make the column automatically resize itself 
to fit all current entries. 

Enter Formulas 
1.  In your checkbook, you want to add your deposit or subtract your debit from your previous balance. 
2.  To let Excel  know that you are typing a formula, start your formula with an equal (=) sign.  In cell F2, 

type =E2­D2. 
3.  In cell F3, type =F2­D3+E3. This formula takes the previous balance from the cell above and then 

subtracts any debits or adds any deposits. 

Copy the formula 
1.  You can now copy this formula to the remaining balance cells.  Excel  is smart enough to update the cell 

references when you move the formula. 
2.  Click cell F3 once to make it the active cell. Choose the Copy button to copy this formula to the 

clipboard. 
3.  Select the block of cells F4 to F6. 
4.  Paste the formula into these cells. To do this, choose the Paste button from your toolbar while your 

block of cells is selected. 
5.  After you have done this you can click any of the balance cells and look at the formula in the formula 

bar (just on top of your spreadsheet). Notice that the formula in each cell is slightly different. 
6.  Try changing the amount of a credit or debit. Notice the balance is automatically updated. 

Save the workbook 
1.  To save the document click on the File menu. 
2.  Click on Save or Save As in the drop­down menu. 
3.  Choose where to save the file. 
4.  In the File Name box type the words Check Book. 
5.  Click the Save button. 
6.  Your work is now saved.
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Excel Monthly Budget 

Instructions: Follow the directions below to create a budget spreadsheet. The last page shows a sample of the 
final product. 

In Excel there is usually more than one way to do something. If a different way to do it occurs to you, go ahead 
and try it! If it doesn’t work, you can always click the Undo button. 

Remember the difference between the active cell and the edit mode: 
• Clicking a cell once makes it active. You can perform actions on the active cell (make it bold or italic, delete 

it, etc.) but you cannot edit the text. 
• To enter the edit mode you must double­click the active cell. Once the insertion point appears, the contents 

of the cell can be changed. 

Entering Column Titles 
1. In cell A1 type Monthly Budget and press ENTER. 
2. In cell A2 type Item, and press the right arrow key or the TAB key to move to cell B2. 
3. In cell B2 type Amount and press the right arrow key or the TAB key to move to cell C2. 
4. In cell C2 type Comments. 
5. Type TOTAL in cell A11, INCOME in cell A13, EXPENSES in A14, and SAVINGS in cell A15. 

Formatting Column Titles 
1. Select the block of cells that have column titles (Item, Amount, Comments) by clicking cell A2, then dragging 

the mouse pointer to cell F2.  The row should be grayed – although the first cell will not be dark. 

Hint: Make sure your mouse pointer is a large white cross when you select the cells. 

2. Click the Bold button on the toolbar. Keep the cells selected. 
3. Click the Format menu and select Cells. 
4. Click the Patterns tab and select a light color from the color choices. 
5. Click OK. 

Move the title, Monthly Budget, to the middle of the spreadsheet 
1. Select cells A1 to F1. 
2. Click the Format menu and choose Cells. 
3. On the Alignment tab click once in the box that says Merge Cells. 
4. Click OK. 

Center the title, Monthly Budget 
1. Select cell A1 (click once in the cell). 
2. Click the Center button.
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Formatting Data 
This is a step you can do before or after entering data. Since we would like to be able to read the column titles 
clearly, we will do this step first. 
1. Select Columns A–F. Essentially you are selecting your entire spreadsheet. To select these cells move your 

mouse pointer to the letter A at the top of the first column. Click once and drag your mouse pointer to the 
letter F and let go. 

2. To resize these columns click Format on the Menu bar. Click Column (which has an arrow on its right side, 
showing you it has options you can choose from) and choose AutoFit Selection. 

Entering Data 
1. Click cell A3. Type Rent (or Mortgage if you prefer) and press ENTER. 
2. Using the arrow keys, or you mouse, move down to cell A4 and type Utilities. 
3. Move down to cell A5 and type Transportation. 
4. Move down to cell A6 and type Food. 
5. Move down to cell A7 and type Medical. 
6. Move down to cell A8 and type Clothing. 
7. Move down to cell A9 and type Leisure. 
8. Move down to cell A10 and type Miscellaneous. 

Hint: As you enter text and data in a cell the format may change, and data may not fit in the column, turning into 
something like #### (or simply cut off). If this happens, move your mouse between the column identifiers (between the 
letters). When the mouse pointer changes to a black cross with arrows, double­click. This will make the column 
automatically resize itself to fit all current data. 

9. Type a numeric estimate (a dollar figure) for each category.  These numbers should start in cell B3 and 
continue to B10 (the Miscellaneous category). 

10. Type a dollar figure for your income in cell B13. 
11. To standardize the B column so that the numbers present a currency style, select cells B3 through B15 and 
click the Currency Style button. 

Entering Formulas 
1. We want to total the B column. To let Excel know that you are typing a formula, always start your formula 

with an equal = sign. In cell B11 type =SUM(B3:B10). You are telling Excel to total the sum of cells B3 
through B11. 

Hint: There are several ways to insert a formula into Excel.  Three other ways to total the B 
column include: 

1. In cell B11 type : =B3+B4+B4+B5+B6+B7+B8+B9+B10. 
2. Highlight cells B3 through B11 then click AutoSum ∑. 
3. Select Cell B11 (click once). 

Click once on = to the left of the Formula bar. 
Click the word SUM next to the drop down arrow to the left of the Formula bar. 
B3:B10 should be in field Number 1. 
Click OK.
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2. In cell B14 type =B11. This inserts the totaled value of your expenses. 
3. In cell B15, type =B13­B11. This is the formula that takes the balance of B11 and subtracts the expenses from 

B14 resulting in the amount left over as savings. 

Finalizing and Saving 
1. Check the spelling in your spreadsheet. Click the Tools menu and click Spelling. 
2. Click the Print Preview button on the Standard toolbar. (If you aren’t sure which button it is move your 

mouse pointer over the buttons until the identifying tag appears). 
• Does the document look the way you want it? If it does, click Close and proceed to save the document 

(see below). If not, click Close and attempt to make the necessary changes. 
2. To save the document, insert a floppy disk into the appropriate disk drive. Click the File menu and click 

Save As. 
3. In the File Name box type the words Budget. 
4. Click the Save button. 
5. Your work is now saved. Close the Excel by clicking the Close (X) button in the upper right corner of the 

screen. 

Sample Budget 

Monthly Budget (March) 
Item  Amount  Comments 
Rent  $    800.00  May 1st this goes to $825.00 
Utilities  $      40.00  Look into new windows 
Transportation  $      50.00  Take the bus 
Food  $    150.00 
Medical  $      25.00  Still owe the co­pay from eye doctor 
Clothing  $      75.00  Try and get this down to $40.00 
Leisure  $    100.00 
Miscellaneous  $    100.00  Largely to birthday's this month 
TOTAL  $ 1,340.00 

Income  $ 2,500.00 
Expenses  $ 1,340.00 
Savings  $ 1,160.00 

© 2002 Bill & Melinda Gates Foundation


